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SHAPING THE FUTURE -- 
TOGETHER! 
Ginger Zech 
2006/2007 Chapter President 
 

sing the theme, “Shaping the 
Future” selected by our new 
International President, 

Sandra Chandler, the 2006-2007 
Union Colony Chapter Board has 
selected to add the word, “Together” 
for our theme.   As we all know, it 
takes a commitment of all the 
members to have a successful year -- 
success in meeting members’ needs, 
success in building our chapter and 
success with being more involved 
with other chapters in our District. 
 
As this year’s Board consists of fairly 
new members to IAAP, and it is the 
first year for any of us to hold an 
office, we are looking forward to the 
support and guidance of past Board 
and Chapter members. As your 
President for 2006-2007, I feel so 
fortunate to have an enthusiastic team 
and the support of such 
knowledgeable and experienced 
people.    
 
Michelle Barraclough, Vice President 
and Chair of the Program Committee, 
is working with her committee 
members to put together the 
programs for this year.  This 
Committee promises a unique 
selection of programs which will be 
announced at the next Chapter 
meeting. 
 
Secretary Harriett Meeker and 
Treasurer Tobi Vegter CPS, have 
also been putting together some ideas 
and suggestions that will be shared at 
future meetings. 
 
I’m looking forward to a rewarding 
year! 
 
Respectfully, 

Ginger 

FLEXIBILITY IN THE WORKPLACE 
 
 

rueling deadlines, long hours, demanding bosses. 
Maybe you don't like them, but you can deal with 
them. But make that a change in the work routine 

and you tense up. You get rigid and uptight. You feel like 
too much is being asked of you.  You liked things the way 
they were. Meanwhile, your coworker adapts and adjusts to 
the new situation with ease. How does she do it, you 
wonder? How can you learn to be flexible without becoming 
the office doormat?  
 
According to The Work Foundation, a London-based think 
tank, companies profit when their employees add flexibility 
to their skill-sets. And flexible people tend to last longer at 
their jobs because they're happier while they're there.  So 
how do those flexible people ebb and flow with office 
fiascos and not get taken advantage of?  Here are some 
quick tips from the pros on how to be flexible when a 
problem arises: 
 
• Listen to what's being asked of you  
 
• Visualize multiple approaches to a problem: drop those 

approaches that aren't working and find new ones  
 

 
• See change as an opportunity, not a threat  
 
• Identify coworkers who are flexible and ask them how 

they do it  
 

 
• Sign up for the office yoga class (hey, whatever works!) 
 
 

www.womenswallstreet.com 
 
 
 
 

U G
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UNION COLONY CHAPTER 

Website: 
www.orgsites.com/co/ucciaap 

MISSION 
Union Colony Chapter is 
committed to: 
• Educational Programs 
• Leadership Enrichment 
• Professional Development 

 
 

2006-2007 OFFICERS 
 

Ginger Zech, 
  President ------------- 970.336.0009 
Michelle Barraclough, Vice 
President ---------------- 970.215.2067 
Harriett Meeker, Secretary 
----------------------------- 970.339.8410 
Tobi Vegter CPS, Treasurer 
----------------------------- 970.330.2685 
 

 

MINI TASK GROUPS 
 

APW Event 
----------- Nancy Upchurch CPS/CAP 
-------------------Sue Young CPS/CAP 
 
Bylaws & Standing Rules 
-------------------------------------------tBD 
 
Education 
-------------- Elaine Furister CPS/CAP 
--------------------------Beth Gibbs CPS 
 
Installation/Membership 
------------------------------Ellen Hetterle 
-------------------Barbara Swetzig CPS 
 
Newsletter 
----------------------Trudy J. Miller CAP 
-------------------- Vi McNew CPS/PRP 
 
Nominations ---------------------- TBD 
 
Program, Publicity, Historian 
------------------------------- Ginger Zech 
 
Scholarship 
----------------------------------------- TBD 
 
Ways & Means---- Tobi Vegter CPS  
 

 

BOARD MEETINGS 
All UCC members are invited 
and encouraged to attend the 
board meetings.  
 

 

 

IT’S WORK, SO DRESS LIKE YOU MEAN IT 
 

oes your office attire scream "I'm off to a rock concert" or do your 
clothes coolly convey a "take-me-seriously" attitude? What you 
wear to the office says something about you to everyone you 

meet; the key is to dress with style and panache, a little bit of creativity 
and a lot of sensitivity to the environment around you. You want to look 
special but you don't want to stick out.  

And whether you acknowledge it or not, you want to look good. Because 
when you look your best, you tend to feel better about yourself and that 
will translate to a more satisfying work experience. (No, that's not a 
scientific statement -- just common sense.) 

Building a business wardrobe starts with figuring out a few things about 
yourself, so here are a few things to think about before you hit the 
stores: 

 Know your style.  What do you feel comfortable, confident and 
powerful in?  

 Know your body. Which hemlines, pant cuts and necklines flatter 
you?  

 Know your workplace or the workplace you want to work in (if you're 
interviewing for a job). Is your office strictly suits or is casual 
business attire allowed? In some industries -- like advertising or 
entertainment -- you can probably be a little more creative with your 
clothes than if you work in a corporate environment.  

 Consider your lifestyle. Do you head out to clubs or to the opera after 
work? With a few quick changes, can you transition from office to 
evening?  

 Which colors flatter you? Which colors make you feel good about 
yourself?  

 What's in your closet? Are there pieces you love that will also work 
for work? Integrating what you already have can save you money. 

And here are some fashion dos and don'ts: 

Don't buy something that's unattractive, thinking "it's just for work." 
That attitude will kill your wardrobe, your budget and make you feel less 
than on top of your game.  

Buy clothing that will work for you in many situations. If you can't see 
yourself wearing something in four or five different situations, it's 
probably not right for you. A simple, well-proportioned suit that can also 
work as separate pieces is a great place to start. Choose a suit that 
makes you feel pulled together and helps you forget to feel self-
conscious. If you can wear the jacket with jeans and boots to catch a 
movie after work you're ahead of the game. Or wear a sweater under 
your suit, and then wear it to the theater, on a date or to a ball game.  

Try to buy clothes that don't have too much going on. A busy outfit is 
like a busybody -- it talks too much. Keep it simple. The whole world 
doesn't need to know that you're really an artist, so save it for the 
people who care about you. Maintain your style with a "less-is-more" 
mantra. 

 
 

DRESS CONTINUED ON PAGE 3 
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NEWSLETTER CONTRIBUTIONS 
 

All committee reports are due at the 
monthly chapter meeting.  All other 
submissions are due to Trudy Miller 
(tjmiller@henselphelps.com) no later than 
the 18th of each month. 
 

SUNSHINE FUND 
Our “Sunshine Fund” is designated for 
events such as births, congratulations, 
deaths, etc. that cannot be funded with 
IAAP monies.  Members may donate $1 
to place their names in a door prize 
drawing.  The winner is then responsible 
for bringing the door prize the following 
month.  (Door prize values can range 
from $5-$10.) 
 

ANNIVERSARY/BIRTHDAY 
 A B 
February 
Mona Boyd CAP ---------- 1998 ----8/25 
Sheri Garland -------------- 2003 ----3/19 
Trudy J. Miller CAP------- 1998 ----- 3/3 
Greta Steinmetz----------- 2006 -- 10/17 
Stephanie Vallejo --------- 2002 ----5/14 
March 
Beth Gibbs CPS---------- 1990* ----4/30 
Ellen Hetterle--------------- 2003 ----2/24 
Barbara Swetzig CPS -- 1990* ----- 9/4 
Nancy Upchurch CPS/CAP1990* --3/23 
Ginger Zech ---------------- 2004 ----12/7 
April 
Michelle Barraclough ---- 2005 ----- 3/9 
Dorothy Brethauer -------- 2001 ----- 5/5 
May 
Esther Camacho ---------- 2004 -- 11/19 
July 
Ann Grotness -------------- 2005 ----11/6  
Mary Lenhart --------------- 1997 ----8/21 
Tobi Vegter ----------------- 2005 -- 11/21 
August 
Cathy Witte CPS ---------- 1996 ----7/28 
October 
Betty Carwin CPS--------- 2000 ----- 3/4 
Melody Hart ---------------- 2005 --- --4/8 
Harriett Meeker------------ 2005 
November 
Sharon Lynch- ------------- 2005 ---  3/19 
Sue Young CPS/CAP---- 1994 ----5/22 
December 
Elaine Furister CPS/CAP- 2000 ----- 3/3 
Rosalinda Rodriguez----- 2005 ----6/26 
Becky Sperber CAP------ 1995 ----- 5/8 
 

* Charter Member 
 

 
 
 

DRESS CONTINUED 
Buy one really terrific pair of shoes. A beautiful pair of shoes that goes 
with everything (or most everything) is better than a different cheap pair 
for every outfit. Make sure your shoes are comfortable without being 
nurse-like. The way you walk speaks volumes; let it be with comfort, 
ease and style. 

Make sure you have the proper undergarments. A black bra under your 
new, white shirt will certainly ruin the effect. Start with the basics and 
build. 

Do remember that you don't have to break the bank to look good at 
work. Keep your eyes open for sales, shop at outlets and choose clothes 
that can be mixed in with what you currently have in your wardrobe.  

   www.womenswallstreet.com 

 
CREATING YOUR OWN EXCEL DEFAULT  WORKBOOK     

 
hen you create a new Excel workbook, you get a standard default 
workbook. But what if you don't like that workbook or spend too much 
time fixing your worksheets? Maybe you have a standard header that 

you always (or almost always) use on printed pages of your workbook. Or 
possibly you prefer a different default font style or size or typically modify the 
layout of column widths in your worksheets. 
 
As it turns out, Excel gives you quite a bit of control over the look and layout of 
your worksheets. It's fairly straightforward to create an entirely customized default 
workbook. The trick behind this magic is creating a template file named 
BOOK.XLT, and then saving that file to the appropriate location on your 
computer. 
 
To create a new default workbook template, all you need to do is customize a blank 
workbook exactly as you want it to look. Some Excel workbook elements you 
might change: 
 
* Font style and font size: Highlight the portions of the worksheet you want to 
change and choose Format > Cells. Select your preferences for number, alignment, 
and font formatting. 
 
* Print settings: Select one or more worksheets and then choose File > Page Setup 
to specify print settings including the header and footer, margins and orientation, and 
indicate other print layout choices. 
 
* Number of sheets: Add or delete worksheets, re-name sheet tabs, and even change 
worksheet tab color. 
 
* Column widths and layout: If you normally prefer different column widths, select the 
columns or even the entire worksheet and then modify the column width. 

 
I was very pleased to see that several members who attended the 
September meeting signed up to serve on a committee.  This is an 

excellent start!  As we can always use a few more volunteers, please give 
some thought to where you could contribute your expertise and time. 

THANK YOU -- GINGER 

W
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CWM DIVISION 
Website: 
www.orgsites.com/co/cwmiaap 
 
2006-2007 OFFICERS 
Cory Scarbrough CPS/CAP, 
President - Denver Downtown 
Chapter; Kyle Sheldon-Chandler, 
President-elect - Book Cliff Chapter; 
Margaret Hartl, Vice President - Rim 
Rock Chapter; Jennifer Borland 
CPS, Secretary - Mountain View 
Chapter; Jalane Glasgow 
CPS/CAP, Treasurer - Book Cliff 
Chapter 
 
CWM DIVISION COMMITTEES 
Annual Meeting ---Glenda Brown CPS/CAP 
--------------------- Darlene Chamberlain CAP 
Bylaws & Standing Rules 
------------------------Jackie Clough CPS/CAP 
Certification ----------- Jalane Glasgow CAP 
Membership ---------------------- Chris Church 
New Chapter Builder Sharon Hunvald CPS 
Newsletter / Website Review 
--------------------------Kyle Sheldon-Chandler 
Nominating -----------------------------------TBD 
Retirement Trust Foundation ------------TBD 
Ways & Means ------------------------------TBD 
  

AROUND THE DIVISION 
Colorado Chapters 
Book Cliff -------------Kyle Sheldon-Chandler  
Boulder-------------------------------Patti Lovato 
Denver --------------------- Andrea Latine CPS 
Denver Downtown* ------------------------- Lisa  
HP Northern Colorado ---Marie Buquo CPS 
IBMC White Eagles Student--- Tara Dubois  
Mountain View ---------------Rolene Cogburn  
Pikes Peak--------------Marilyn Sullivan CPS 
Union Colony---------------------- Ginger Zech 
Wyoming Chapters 
Old West--------------- Karen Schroeder CPS 
Western Horizons ------------Corina Draycott 
Montana Chapters 
Rim Rock -------- Darlene Chamberlain CAP 
 
* Breakfast Meeting 
** Lunch Meeting 

 
 
IAAP SPONSORS 
 
www.officeteam.com 
www.mmm.com/office 
www.avery.com 

 

 

POSITIVE DIFFERENCES 
 

t’s a great day to be alive and making a positive difference at work 
and home, isn’t it? 

 
Now for a reality check…. If you glossed over that sentence, please 
pause a moment and reflect: Do you actually feel that way? I hope 
you believe it to the core – because sometimes, it can be hard to stay 
enthusiastic about our daily routines or see how our contributions 
impact the big picture. And when that happens, we’re less likely to 
live to the fullest or do our best – and more likely to skate by. 
 
It takes courage and stamina to wake each morning, come what may, 
and say, “I will make the most of every minute!” With that in mind, 
here are some ways you can bolster your courage to live more fully 
and enjoy greater success in all your endeavors: 
 

• Live honestly. I’m not talking here about following rules and 
regulations and being a good person. That’s a given. I mean 
this: Strive at all times to be true to what Sarah Ban 
Breathnach, author of Simple Abundance, calls “your 
authentic self.” If you live what you believe – and 
consciously use your words and deeds to reflect those beliefs 
(not always easy, mind you) – you’ll own your life and the 
way you live it. You’ll be the best you can be and experience 
even more satisfaction in all you do—guaranteed.  

 
• Embrace change. Change is the only constant in life, so why 

ignore, sidestep or fight it? Instead, view it is an opportunity! 
Choose to become a part of the action, rather than the human 
equivalent of flotsam or jetsam, tossed hither and yon without 
exerting any will. Where’s the joy in that?  

 
• Keep an open mind. Human beings are creatures of limited 

knowledge. We cannot know everything, no matter how hard 
we try! Therefore, we must have the courage to stay 
inquisitive and change our minds when necessary. Not always 
a comfortable thing to do, certainly. But the benefits far 
outweigh the risks – namely, apathy and stagnation.  

 
• Be adventurous. Today is a new day, no matter how similar 

to yesterday, tomorrow, next week or month it may seem. 
Mold today as you would a piece of clay. Think: What would 
make this day outstanding? Now, what’s holding you back? 

Joan Burge; ©Office Dynamics, Ltd., 2006 

I 
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2006-2007 INTERNATIONAL 
BOARD OF DIRECTORS 

 

President, Sandra P. Chandler CPS; 
President-Elect Judy McCoy CPS/CAP; 
Vice President Tia Theriaque CAP; 
Secretary Barb Horton CAP; Treasurer 
Susan K. Shamali CPS/CAP; Affiliate 
Representative Leanne Fisher AOP/JP; 
Canada District Director Kathryne 
Hampton CPS/CAP; Great Lakes 
District Director Sam W. Gill III CPS; 
Northeast District Director Marie “Gerry” 
Burnell CPS/CAP; Northwest District 
Director Teresa G. Bennett CPS; 
Southeast District Director Tamra L. 
Goodall CPS/CAP; Southwest District 
Director Karlena Rannals CPS/CAP 
 
2006-2007 INTERNATIONAL 
RETIREMENT TRUST 
FOUNDATION TRUSTEES 
 

 

: 
(l-r)Linda M. Cook CPS/CAP, Vice 
Chairman; C. Joyce Hawkins CPS/CAP, 
RTFC Liaison; Janine Riemersma 
CPS/CAP, Chairman; 
Barbara G. Carter CPS/CAP, Secretary; 
Sandra P. Chandler CPS,  IAAP 
International President; Susan K. 
Shamali CPS/CAP, IAAP International 
Treasurer 
 
2006-2007 COLORADO-
WYOMING-MONTANA DIVISION 
BOARD OF DIRECTORS 

 
 
(l to r) Cory Scarbrough CPS/CAP, 
President; Kyle Sheldon-Chandler, 
President-elect; Margaret Hartl, Vice 
President; Jennifer Borland CPS, 
Secretary; Jalane Glasgow CPS/CAP, 
Treasurer  
 
 

PARLIAMENTARY EXPERIENCE:  PROTOCOL 
– Vi McNew CPS/PRP 

Boulder Chapter Member 
 

rotocol involves courtesy and consideration given to guests and honored 
members of our Association. 
In our IAAP Chapters, the matter of protocol is left up to the presiding 

officer or the program chairman. This involves seating guests, honored 
members, and/or past presidents, paying attention to their rank and seating 
them in the correct pecking order. If there are opening ceremonies involved, 
this could include arranging for a clergyman to present the invocation, a leader 
for the flag ceremony, music, and the like. 
In seating arrangements, the president is always in the center, the first ranking 
guest on the right of the president, the second ranking guest on the left of the 
president. This seating is continued until the head table (platform) is filled. 
When introducing guests, the highest ranking official is presented frst; however, 
if the guests are expected to say a few words, begin with the lowest rank and 
continue up the scale with the highest rank last to give this person prominence 
and the opportunity to speak the longest. When presenting past presidents, 
always give the year of their administration. It is absolutely essential that each 
name be properly pronounced and should be rehearsed by the person making 
the introductions. 
Special or honored guests should be invited in advance and should be advised 
as to the place, hour at which they are to be presented, the length of time for 
their presentation and whether or not they will be expected to answer 
questions. It is well to contact a speaker a couple of days before the date of the 
meeting to make sure all details have been confirmed. These include 
transportation to and from the airport, hotel reservations, and payment of the 
fee/honorarium, if any. The person in charge of protocol (or a designated 
person) should meet the guest and introduce the guest to the president and 
other officers if they have not previously met. Honored guests should never 
stand in line for refreshments. The secretary of the organization should 
promptly send a "thank you" note on behalf of the organization. 
ach chapter has its own way of seating officers at meetings. It is this writer's 
opinion that it is much easier for the presiding officer to have the current officers 
(vice president, secretary, treasurer, parliamentarian) seated at a table facing 
the membership for the simple reason if the presiding officer needs to confer 
with one of these officers, it is less of an interruption to the assembly to have 
that officer near at hand. As noted above, the presiding officer is always in the 
center; a proven successful seating arrangement is for the secretary to be 
seated to the presiding officer's right and the parliamentarian to the presiding 
officer's left, with the vice president next to the secretary and the treasurer next 
to the parliamentarian. 
There is not, to my knowledge, any hard and fast rule about this and whatever 
is comfortable for the president (presiding officer) should be followed. If there is 
a guest speaker, this speaker should be seated, as noted above, to the right of 
the president. In larger meetings, such as a Division meeting, if a head table is 
used, it will require adjusting the officer seating to allow for the additional 
persons; many times this can be handled by having the vice president, 
secretary and treasurer seated in the assembly until the opening ceremonies 
have been accomplished. The clergy/city official are then given the opportunity 
to leave and the officers can then join the president for the commencement of 
the business meeting. 
The important thing to remember is to give the honored guests and visiting 
officials the proper recognition. This contributes to the esteem of the 
organization and is well worth the time and effort in seeing that rank is properly 
recognized. 

P
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IAAP EVENTS 
 

 

INTERNATIONAL CONVENTIONS 
 
 

July 29-August 1, 2007 
Tampa Convention Center 
Tampa, FL 
 

July 27-30, 2008 
Hilton New Orleans Riverside 
New Orleans, LA 
 

July 26-29, 2009 
Minneapolis Convention Center 
Minneapolis, MN 
 

July 18-21, 2010 
Hynes Convention Center 
Boston, MA 
 

July 18-21, 2010 
Hynes Convention Center 
Boston, MA 
 

July 24-27, 2011 
Montreal Palais de Congress 
Convention Center 
Montreal, Quebec 
 

July 22-25, 2012 
Gaylord Texan Resort 
Grapevine, TX 
 
CERTIFICATION CONFERENCE 
 

October 15-18, 2006 
Marriott Rancho Las Palmas 
Resort & Spa – Palm Springs, 
CA 
 

October 14-17, 2007  
Hyatt Regency San Antonio  
San Antonio, TX 
 
October 19-22, 2008  
Grand Hyatt Hotel  
Denver, CO 
 
PROFESSIONAL EDUCATION 
CONFERENCE 
 
 

March 4-7, 2007 
Hyatt La Jolla – San Diego, CA 
 
March 2-5, 2008 
Charleston Riverview Hotel 
Charleston, SC 
          
 

 POWERPOINT – DESIGNING PRESENTATIONS 
 

How Easy Are Your Slides to Read? 
 
Too many presentations are so packed with information they can be 
illegible. Even complex and confusing slides may be readable if 
viewed only 18 inches away from a computer monitor. 
Try this simple test. Switch to View > Slide Sorter and then choose 
a 66% view from View > Zoom or the Zoom toolbar button. If you 
cannot read the slide without a magnifying glass, consider using a 
larger font, fewer words and/or higher contrast. 

Creating the Perfect Circle, Square, Star, and More  
If you have even tried to draw a circle or square on a slide, you might 
have noticed that the tool is actually called ellipse or rectangle which 
does not automatically give you a perfectly 
proportional shape. 

The next time that you want an evenly proportioned shape, select the 
toolbar or AutoShape option that you want, press and hold down 
[Shift] and then draw the object. Release the mouse before letting go 
of the [Shift] key and you will have a perfect circle (or square). Hold 
[Shift] again if you need to resize the shape. 

This trick can also be used for drawing other shapes including stars, 
octagons, triangles, and more. 

Quickly Copy a Shape  
Do you want more copies of your perfect shape? Here's an easy way 
to make a copy: 

1) Click once on the shape to select, 2) Press and hold down [Ctrl] 
and drag the object to create a copy in a new location. 

Easy Alignment:  
If you want the original and the copy to be evenly aligned either 
horizontally or vertically, follow the steps above but also add the 
[Shift] key which will "constrain" or limit your movement to be only 
across or up and down. 

Limit Your Lines  
Most shapes will look more professional onscreen without an outside 
line or border. To remove the line: 1) Select the object, 2) Click on 
the drop-down arrow next to the Paintbrush tool in the Drawing 
toolbar. 

 
www.Softwarepro.com 
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IAAP Information 
 

UNION COLONY CHAPTER 
PO Box 336578 
Greeley CO  80633 
Website: 
www.orgsites.com/co/ucciaap 

 

 
NW DISTRICT DIRECTOR 
Teresa Bennett 
 
 
 
 

IAAP HEADQUARTERS 
PO Box 20404 
Kansas City MO  64195-0404 
----------------------- 816.891.6600 
-----------------Fax: 816.891.9118 

Web Site:------- www.iaap-hq.org 
 
 

Union Colony Chapter 
Upcoming Calendar 

 

Our Agenda 
Social/Networking------- 5:30 PM 
Program ------------------- 6:00 PM 
Business ------------------ 7:00 PM 
 

 

Aims College Center 
Room 729 

 

October 11, 2006 
Appreciation Night 

 

 
 
 
 
 

 
 
 
 

TAKING EFFECTIVE NOTES 
 

hether you are taking a class, receiving training for a new office 
program, or doing research for an upcoming project, you need 
to take accurate, organized notes. Graphic organizers can be a 

big help for remembering important points. Here are a few you might try. 
 

• Lists—create lists to help you pinpoint main ideas. 

• Flowcharts—these are most effective when taking notes about a 
process or cycle. Use boxes and arrows to show the ‘flow’ of 
information. 

• T-Bars—use a T-bar for noting pros/cons, before/after, 
problems/solutions, and other information that has two sides or 
parts. 

• Venn diagram—the overlapping circles allow you to compare 
two topics by separating similarities and differences of two ideas. 

• Clusters—these graphics allow you to note key ideas and their 
details. 

• 5 W's Chart—this chart includes columns to list the “who,” 
“what,” “where,” “when,” and “why” of ideas. 

 
When you’re learning something new, taking well-organized notes is half 
the battle. Select the graphic organizer that works best for you and 
adjust it to fit your own style. 

Upwrite Press 

 

"A discovery is said to be an accident meeting a prepared mind." 

--Albert Szent-Gyorgyi (1893 - 1986) 

 
A NOTE FROM YOUR DIVISION PRESIDENT 

 
The Division has agreed to waive dues for anyone who joins 
during October/November, the months where most chapters 
will be conducting their IMPACT meetings. 
 
 

Corinna A. Scarbrough CPS/CAP 

 

“I know what I know and I 

write it.” 
—Octavio Paz, Nobel Prize—Literature, 

1990 

 

W
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Union Colony Chapter IAAP Calendar of Events 

Date Event 
2006 
October 11 Appreciation Night - Mary Scheid with Breast Health info 

November 8 “Career-Minded Administrative Professionals Challenge the status quo of IAAP” – 
Beth Gibbs CPS / Nancy Upchurch CPS/CAP 

December 13 Writing with Romance (and Creativity) - Kathy Kramer, Boulder Chapter 
 
IAAP ANNUAL CONVENTION & EDUCATION FORUM FUTURE DATES/SITES 

2007 July 29-August 1 Tampa Convention Center Tampa, Florida 
2008 July 27-30 Hilton New Orleans Riverside New Orleans, Louisiana 
2009 July 26-29 Minneapolis Convention Center Minneapolis, Minnesota 
2010 July 18-21 Hynes Convention Center Boston, Massachusetts 
2011 July 24-27 Montreal Palais de Congress Convention Center Montreal, Canada 
2012 July 22-25 Gaylord Texan Resort Grapevine, TX 
 
SPRING PROFESSIONAL EDUCATION CONFERENCE FUTURE DATES/SITES 

2007 March 4-7 Hyatt La Jolla  San Diego, California 
2008 March 2-5 Charleston Riverview Hotel  Charleston, SC 
 
IAAP CERTIFICATION CONFERENCE (FOR CPS AND CAP HOLDERS AND APPROVED CANDIDATES) DATES/SITES  

2006 October 15-18 Marriott Rancho Las Palmas Resort & Spa Palm Springs, California 
2007 October 19-22 Grand Hyatt Hotel  Denver, CO 
 


